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1.1 Introduction

The latest FMCSA IT Development Division release includes the following software:

 Current Software Version Release Date Required Upgrade Date You can upgrade from
version:

Aspen 2.10 September 29, 2008 December 29, 2008 2.9.1

CAPRI 6.7 September 29, 2008 December 29, 2008 6.6.3

CaseRite 3.9 September 29, 2008 December 29, 2008 3.8.1

CDLIS Access 3.4.3 September 29, 2008 December 29, 2008 NA

eFOTM 2.4 July 28, 2008 NA 2.3

ISS 2.12.3 September 29, 2008 December 29, 2008 2.12.2

PIQ 2.10 September 29, 2008 December 29, 2008 2.9.1

ProVu 3.1.3 September 29, 2008 December 29, 2008 3.1.2

SAFETYNET 3.6 September 29, 2008 December 29, 2008 3.5

UFA 3.2 September 29, 2008 December 29, 2008 3.1.1

Firebird 1.5.1 NA NA NA

Each of these applications is available for download from the FMCSA Information Systems Web site.

Note Only the upgrade installer of SAFETYNET 3.6 is available for download. A full, fresh install requires a CD that can be
obtained from FMCSA Technical Support.

These applications have been tested and are supported on the Microsoft Windows 2000 SP 4 and XP SP 2 operating systems.

Please install the software as soon as possible, but no later than the required upgrade date. If you do not have the version
noted in the right column of the above table installed, please uninstall your older version before installing the latest version
(refer to the following upgrading section for more information). 

1.2 Upgrading the Applications

1.2.1 Aspen

To upgrade to Aspen 2.10, you must have Aspen 2.9.1 installed. If you do not have Aspen 2.9.1 installed, please uninstall the
older version of Aspen before installing Aspen 2.10. As always, remember to back up your work.

IMPORTANT: SAFETYNET MUST be upgraded to version 3.6 BEFORE importing Aspen version 2.10 inspections.

Note: There have been significant changes in the applications including database changes that may affect users. The FMCSA
recommends that all Aspen and SAFETYNET users finalize and upload ALL inspections prior to upgrading.

Note To ensure ISS, PIQ, and Aspen work together properly, you must have the following versions installed: Aspen 2.10, ISS
2.12.3, as well as PIQ 2.10. 

1.2.2 CAPRI

To upgrade to CAPRI 6.7, you must have CAPRI 6.6.3 installed. If you do not have CAPRI 6.6.3 installed, please uninstall the
older version of CAPRI before installing CAPRI 6.7. Upgrading to CAPRI 6.7 should not result in the loss of any data. However,
it is highly recommended that you perform a backup of all user-generated data before installing CAPRI 6.7.

http://infosys.fmcsa.dot.gov/
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IMPORTANT: CAPRI 6.7 requires the Firebird database client version 1.5.1. You must uninstall any older Firebird version
before installing Firebird 1.5.1. You must have administrative rights to your computer to install the FMCSA IT Development
Division software.

To uninstall Firebird

1. From the MS Windows Control Panel, Click Add or Remove Programs.

2. Select Firebird and click Remove.

3. Follow the prompts to remove the application.

To install Firebird

1. Download Firebird 1.5.1 from the FMCSA Information Systems Web site.

2. Double-click the Firebird download to start the installation.

3. Follow the prompts using the default settings to install Firebird.

Note To ensure CAPRI, CaseRite, and UFA work together properly, you must have the following versions installed: CAPRI 6.7,
CaseRite 3.9, and UFA 3.2.

IMPORTANT: Install both Firebird 1.5.1 and CAPRI 6.7 prior to launching CAPRI 6.7 for the first time.

1.2.3 CaseRite

To upgrade to CaseRite 3.9, you must have CaseRite 3.8.1 installed. If you do not have CaseRite 3.8.1 installed, please
uninstall the older version of CaseRite before installing CaseRite3.9. As always, remember to back up your work.

Note To ensure CAPRI, CaseRite, and UFA work together properly, you must have the following versions installed: CAPRI 6.7,
CaseRite 3.9, and UFA 3.2. 

1.2.4 CDLIS Access

To upgrade to CDLIS Access 3.4.3, please uninstall any previous versions of CDLIS Access, and then install CDLIS Access
3.4.3. As always, remember to back up your work. 

1.2.5 eFOTM

If you had eFOTM 2.3 installed, you will automatically be upgraded to eFOTM 2.4 the next time you open eFOTM. If you did
not have eFOTM 2.3, please download and install eFOTM 2.4 from the FMCSA Information Systems Web site. 

1.2.6 ISS

To upgrade to ISS 2.12.3, you must have ISS 2.12.2 installed. If you do not have ISS 2.12.2 installed, please uninstall the older
version of ISS before installing ISS 2.12.3. As always, remember to back up your work.

Note To ensure ISS, PIQ, and Aspen work together properly, you must have the following versions installed: Aspen 2.10, ISS
2.12.3, as well as PIQ 2.10. 

1.2.7 PIQ

To upgrade to PIQ 2.10, you must have PIQ 2.9.1 installed. If you do not have PIQ 2.9.1 installed, please uninstall the older
version of PIQ before installing PIQ 2.10. As always, remember to back up your work.

Note To ensure ISS, PIQ, and Aspen work together properly, you must have the following versions installed: Aspen 2.10, ISS
2.12.3, as well as PIQ 2.10. 

http://infosys.fmcsa.dot.gov/
http://infosys.fmcsa.dot.gov/
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1.2.8 ProVu

To upgrade to ProVu 3.1.3, you must have ProVu 3.1.2 installed. If you do not have ProVu 3.1.2 installed, please uninstall the
older version of ProVu before installing ProVu 3.1.3. As always, remember to back up your work.

1.2.9 SAFETYNET

Please refer to the readme.pdf included with the SAFETYNET download for installation/upgrade instructions.

IMPORTANT: SAFETYNET MUST be upgraded to version 3.6 BEFORE importing Aspen version 2.10 inspections.

Note: There have been significant changes in the applications including database changes that may affect users. The FMCSA
recommends that all Aspen and SAFETYNET users finalize and upload ALL inspections prior to upgrading.

Note: Only the upgrade installer of SAFETYNET 3.6 is available for download. A full, fresh install requires a CD that can be
obtained from FMCSA Technical Support. 

1.2.10 UFA

To upgrade to UFA 3.2, you must have UFA 3.1.1 installed. If you do not have UFA 3.1.1 installed, please uninstall the older
version of UFA before installing UFA 3.2. As always, remember to back up your work.

Note To ensure CAPRI, CaseRite, and UFA work together properly, you must have the following versions installed: CAPRI 6.7,
CaseRite 3.9, and UFA 3.2. 

1.3 Installation

All FMCSA IT Development Division software must be installed and uninstalled by a user with administrative rights. Before
continuing with the installation, please verify that you have administrative rights on the computer to which you are installing the
applications, or locate your administrator to complete the installation.

1.3.1 Installing the IT Development Division Software

From the FMCSA Information Systems Web site, you will download and launch the individual installers for each application.
These installers will determine if there is adequate disk space.

Note After completing all installations, you need to restart your computer to enable all systems.

IMPORTANT: Before installing the software, please close all other applications.

To install the FMCSA IT Development Division Software

1. Go to the Software/Documents section of the FMCSA Information Systems Web site.

2. Select the link to the software that you wish to download and install.

3. Click the Download Now link.

4. Click Save to save each installation to your local drive.

5. Navigate to each installation on your local drive and double-click to install.

6. Follow the prompts for each installation.

1.3.2 Installing the Cisco Systems VPN Client

If you need to access the FMCSA systems from a remote site, and do not have a VPN client already installed on your machine,
you will need to download and install the Cisco VPN Client. Before installing, please read the VPN installation instructions.

https://infosys. fmcsa.dot.gov
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1.3.3 Installing Firebird

If you are a first-time CAPRI or UFA user, you will need to install Firebird 1.5.1.

1.4 Configuring the Applications for the Power Users

If you are installing these applications to a Windows XP environment for a Power User, you will need to change the user

permissions to enable the Power User to modify application data. Without this ability, Power Users will be unable to access or

update an applications database.

Step 1 Log on to the computer with administrator rights.

Step 2 From the Start menu, select My Computer.

Step 3 From the Tools menu, select Folder Options.

Step 4 Click the View tab.

Step 5 Scroll to the bottom of the list, clear the Use Simple File Sharing check box, and click OK.

Step 6 Right-click the FMCSA IT Development Division application folder on which you want to change

permissions, for example:

· C:\FSGApps
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· C:\CASERITE_ECPS

· The directory where you selected to install the application

Step 7 Select Properties.

Step 8 Click the Security tab.

Step 9 Choose from the following options:

If Power Users does not appear in the list:

1. Click Add.

2. Type Power Users and click OK.

Note If From this location does not display your computer name, click the Locations button and select your computer.

If the Power User group already appears, go on to step 10.

Step 10 Select the Power Users group.

Step 11 Click the Modify box.
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Step 12 Click Ok.

1.5 Fixes and Enhancements

This section outlines the various fixes and enhancements that have been made to the FMCSA IT Development Division
release.

1.5.1 Aspen

The Aspen driver/vehicle safety inspection system enables law enforcement agencies to perform roadside safety inspections
and to transfer those inspection results into the State and National data systems.

Note: There have been significant changes in the applications including database changes that may affect users. The FMCSA
recommends that all Aspen and SAFETYNET users finalize and upload ALL inspections prior to upgrading.

Fixes to Aspen 2.10

· An issue that caused the Custom State list to display improperly when the Custom State list was defined with states
from two countries has been fixed.

Enhancements and Other Modifications to Aspen 2.10

· "Both Bulk & Non-Bulk" has been added as a selection to the Hazardous Materials Inspection Type list.

· When performing a Level VI inspection, the UN Number field now allows you to select the UN Number from a list,
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which automatically populates the Proper Shipping Name field.

· The Cargo Seal Removed # and the Cargo Seal Replaced fields have been added to Finish tab.

· Aspen inspections with Colonia names up to 100 characters can now be transferred to other systems.

· Aspen has been updated to include Level VII inspections. NOTE: FMCSA inspectors, safety investigators, and
contractors working on FMCSA's behalf are precluded from performing Level VII inspections. The definition of Level VII
inspections specifically applies to vehicles that are NOT subject to the FMCSR.

· The Transport Index (TI) and Safety Index (CSI) fields on the Level VI Radiological Tab have been updated to properly
format the entered data.

· Aspen has been updated so that both the OOS and VI OOS fields on the Violations tab CANNOT both be set to Y.

· Aspen now supports Performance Based Brake Testing (PBBT) and record-keeping. When the user selects to perform
a PBBT inspection, a new PBBT tab has been added to collect the PBBT measurements.

· Aspen has been updated so that a Brake Advisory prints on the Inspection Report for any inspection that includes a
393.53(b) violation.

· The Vehicle Make codes look-up table has been replaced in order to re-baseline the table. Several new manufacturers
have been added. Any custom vehicle makes that have been added by the user will have to be replaced after the
update.

· The Aspen32 Data Dictionary.pdf document has been updated.

· Aspen has been updated to expand the number of Special Studies fields from five to ten. All ten Special Studies fields
have been increased to 40 characters in length.

· "Existing CVSA Decal #" and "Existing CVSA Decal Status" fields have been added to the Finish tab. These fields will
be used to record existing Commercial Vehicle Safety Alliance (CVSA) Decal data during an inspection.The previously-
existing decal field is now labeled CVSA Decal Issued #, and will be used to record any new decal issued as the result
of an inspection.

· Aspen now imports the MC/MX number from Query Central.

· The "OOS #" field on the Finish tab has been relabeled as "OOS Sticker #".

· The Inspector Notes and the Special Studies fields have been combined into one report.

· The "Existing CVSA Decal #" field and the "CVSA Decal Issued #" now print on the Aspen report.

·  The pop-up message that requested users to enter the existing CVSA decal in the Inspection Notes has been
removed.

· The "Vin #" field on the Vehicle tab has been relabeled as "VIN". 

· The Brake Information section has been updated to correct the Maximum values for two Long Stroke Clamp types: L-
24 and L-24*.

· When a 393.47(e) violation is added for the first time, the following alert appears: "You have selected 393.47(e), is this
vehicle required under 393.53(b) to be equipped with an automatic brake adjustment system?" If you select yes, the
393.53(b) violation is automatically added to the violation list.

· The user Help has been updated.

· The Violation Table has been updated. To see the complete Violation Table, refer to the Documents section for Aspen
on the FMCSA Information Systems Web site.

· The Public version of Aspen 2.10 will be created and released after September 29, 2008 in accordance with the
Freedom of Information Act (FOIA).

http://infosys.fmcsa.dot.gov/
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1.5.2 CAPRI

The Compliance Analysis and Performance Review Information (CAPRI) system provides a standardized method for
conducting reviews on motor carriers, HM shippers, and cargo tank facilities. It is also used for Safety Audits on new carriers
and Mexican carriers seeking to operate in the United States.

Fixes to CAPRI 6.7

· The Household Goods (HHG) Worksheet question for 375.519 (b) has been corrected.

Enhancements and Other Modifications to CAPRI 6.7

· CAPRI now allows a Security Contact Review (SCR) to be performed with any other review type.

· A potential rating on the non-ratable Comprehensive Safety Analysis 2010 (CSA2010) review type will now be
generated. 

· The CAPRI table of violations report will now be uploaded to EDMS.

· The CSA 2010 Causal Factors, Remedies, and Reasons for Review have been applied.

· The address information for several Division Offices has been updated.

· The documents table was updated to reflect new language in the Part B Reports for Unsatisfactory Rating – 60 Day
Rule.

· The user Help has been updated.

· The Public version of CAPRI 6.7 will be created and released after September 29, 2008 in accordance with the
Freedom of Information Act (FOIA).

1.5.3 CaseRite

CaseRite is designed to automate and improve the quality of the enforcement case preparation process. It is part of FMCSA's
suite of investigation software and shares data with CAPRI, UFA, and Aspen.

Fixes to CaseRite 3.9

· The word wrap function in Uniform Fine Assessment (UFA) Notes on the UFA Report has been fixed.

· An issue that caused CaseRite to produce blank applicable statutes for OOS has been fixed.

· An  issue that resulted in recordkeeping violations not being printed as the type of violation (on the NOC) has been
fixed. 

Enhancements and Other Modifications to CaseRite 3.9

· Aspen Inspections that have been transferred (with a T status code) can now be used to start a new case in CaseRite.

· CaseRite no longer requires a separate installation for the Long NOC.

· The Applicable Statutes language has been updated.

· The UFA Employee Model applicable statues have been added to CaseRite.

1.5.4 CDLIS Access

The Commercial Driver License Information System (CDLIS) Access is a network of state driver license systems linked via a
central site, which enables national access to any driver license status or history of safety violation convictions.
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Fixes to CDLIS Access 3.4.3

· An issue that caused an Invalid Use of Keyword error when a driver's name contained an apostrophe has been fixed.

Enhancements and Other Modifications to CDLIS Access 3.4.3

· The Canadian state of Nunavut (NU) has been added to the selection of Canadian states and provinces.

1.5.5 eFOTM

The electronic Field Operations Training Manual presents investigation procedures and techniques in an electronic format. The
manual is a tool to help you plan and complete simple, unusual, unique, and/or difficult investigations.

Fixes to eFOTM 2.4

· None

Enhancements and Other Modifications to eFOTM 2.4

· The following eFOTM topics have been updated:

o Conclusion of Investigation and Completion of Part C

o Controlled Substances Subpart O Enforcement Initiative (MC-ECE-0022-06)

o Investigative Foreword

o Part 390 - Investigative Procedures

o Part 392 - Investigative Procedures

o Special Topic: Motor Carriers of Passengers

o Special Topic: Starving Students

o What is the Certification Cycle for Safety Investigators, Safety Auditors, and Safety Inspectors?

o When should an investigation be conducted?

· The following eFOTM forms have been converted to interactive forms that can be filled out electronically:

o Safety Audit Illustration SA-2 - Contact Record    

o Service Checklist

o Guidance On Steps to Take When Considering An Imminent Hazard OOS Order

o Hazardous Materials Violation Notification

o Hazardous Materials Regulations That Apply To Cylinders Checklist

o Indicators of Hazardous Material Violations for All Portable Tanks

o Indicators of Hazardous Materials DOT 51 - Portable Tank Violations

o Indicators of Hazardous Material DOT 56-57 Portable Tank Violations

o Indicators of Hazardous Materials IM 101 or IM 102 - Portable Tank Violations

o Indicators of Hazardous Materials Shipment Violation - Cylinders

o Indicators of Hazardous Materials Shipment Violations - Hazardous Materials
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o Release of Information Form - 49 CFR Part 40 Drug and Alcohol Testing

o Indicators of Hazardous Materials shipment Violations - Hazardous Waste and Hazardous Substances

o Indicators of Hazardous Materials Shipment Violations - Radioactive Materials

o Hazardous Materials Regulations That Apply To Cylinders Checklist

o RAM Checklist

o Guidance On Steps to Take When Considering An Imminent Hazard OOS Order

o Indicators of Hazardous Material Shipment Violations Explosives

o Mexico-domiciled OP-1 (MX) Applicant Pre-authorization Safety Audit  –  Contact and Scheduling Form

o Mexico-domiciled OP-1 (MX) Applicant Pre-authorization Safety Audit Phase 1 – Verification Checklist

· The following topics have been added:

o How does an emergency condition requiring immediate response impact my review of a motor carrier?

o How will I ensure the carrier is in compliance with SAFETEA-LU Section 4114? 

o Illustration SACN-2

o Illustration SACN-3

o New Entrant Call Center Process

· The following memos have been added:

o Certification for Conducting Compliance Reviews, Safety Audits, and Level I or VI Inspections 

1.5.6 ISS

The Inspection Selection System (ISS) enables screening of vehicles based on DOT number, MC/MX number, State number,
or carrier name. ISS returns the carrier name and address, an inspection value, and other decision indicators to help measure
the value of conducting an inspection. This install includes the most recent monthly database update.

Fixes to ISS 2.12.3

· An issue that caused the one and two month data refreshes to become non-functional has been fixed.

Enhancements and Other Modifications to ISS 2.12.3

· ISS now displays a Deficient BASIC alert in a pop-up window.

· The user Help has been updated.

1.5.7 PIQ

The Past Inspection Query (PIQ) accesses a national database of recent inspection reports. This database contains inspection
reports for the previous 180 days. PIQ retrieves an exact facsimile of previous inspection reports stored in the database.

Fixes to PIQ 2.10

· None

Enhancements and Other Modifications to PIQ 2.10

· The Aspen/SAFETYNET VIN validation routine has been applied to PIQ queries.
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· Changes will be made in the PIQ inspection report, based on changes made to the Aspen inspection report. These
changes include:

o Inspector Notes are now available in PIQ and have been combined with the Special Studies fields into one report.

o When available, Performance Based Brake Testing (PBBT) inspection information now displays in the PIQ report.

o Five (5) Special Studies fields have been added. All 10 Special Studies fields have been increased to 40
characters in length.

o The new Existing CVSA Decal # field now displays on the PIQ report.

· The user Help has been updated.

1.5.8 ProVu

ProVu is a viewer that allows Federal, State, and private industry users to electronically analyze standard motor carrier safety
profile reports available from the Federal Motor Carrier Safety Administration.

Fixes to ProVu 3.1.3

· None.

Enhancements and Other Modifications to ProVu 3.1.3

· ProVu has been updated to display the full country name (rather than an abbreviation) on the Company page.

1.5.9 Query Central

Query Central is an intelligent query system designed to dramatically increase access to motor carrier safety information for
State and Federal law enforcement personnel.

Fixes to Query Central

· An issue that resulted in Size & Weight printing twice under the Special Checks section of the Inspection Report
Display has been resolved.

· An issue that resulted in the Query Central Report printing the violation code instead of the regulation citation on the
Inspection Report has been resolved.

· An issue where past inspections for the driver were not returned when searching by Social Security Number in Query
Central will be resolved.

Enhancements and Other Modifications to Query Central

· Inspector Notes are now available when viewing a past inspection in Query Central.

· The Carrier's MC/MX number is now included in the Aspen download.

· The Query Central Carrier Snapshot report now displays Insurance Status.

· A warning message is now displayed when the entity selected is “Shipper Only”.

· Past inspections for vehicles can now be queried by CVSA sticker number.

· Performance Based Brake Testing (PBBT) data now displays on inspection reports when applicable.

· The Canadian territory of Nunavut (NU) has been added to the selection of Canadian provinces and territories on a
vehicle query.

· A drop-down list of Mexican states has been added to the Vehicle State/Plate query interface.

· Changes have been made to ensure the QC inspection report replicates the Aspen inspection report, including
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enhanced CVSA sticker reporting and changes to the Special Studies fields.

· More informative carrier Out of Service (OOS) text is now displayed.

· The user Help has been updated.

1.5.10 SAFETYNET

SAFETYNET is a system designed to manage and provide appropriate access to crash data, roadside inspection history and
data, and motor carrier and shipper identification information.

Note: There have been significant changes in the applications including database changes that may affect users. The FMCSA
recommends that all Aspen and SAFETYNET users finalize and upload ALL inspections prior to upgrading.

Fixes to SAFETYNET 3.6

· An issue with violation counts on the SAFETYNET Report have been resolved. 

Enhancements and Other Modifications SAFETYNET 3.6

· Extra spaces in the "HM 4-digit Number" field of the crash module have been deleted.

· HM Package type field will allow for values of "Bulk, Non-Bulk, and Both."

· Fields to capture Cargo Seal Removed and Cargo Seal Replaced have been added.

· The CVSA Level VII Inspection program has been implemented.

· Enhancements to the Carrier Matching algorithm have been implemented.

· Fields for gathering data from a PBBT inspection and indicating violations resulting from these inspections are now
provided.

· An advisory will appear on the Driver/Vehicle Examination Report for inspections with brake adjustment violations when
the vehicle is required to have automatic slack adjusters.

· A change has been made to the Inspector Profile Workload Report.

· Vehicle Make codes will be updated.

· Issues with the Crash Facsimile Report have been resolved.

· An issue with violation counts on the SAFETYNET Report have been resolved.

· A spelling error in the Inspection and Crash module ("labelled") has corrected.

· The Special Study fields have been enhanced. There are now 10 available, and each has a standard length of 40
characters.

· The number and status of existing CVSA decals at inspection will be captured.

· The width of the Colonia field has been increased to 100 characters.

· The display values for the long-stroke brake chamber measurements have been revised to ensure consistency.

· The Help file has been updated to include information for the pre-authority safety audit (PASA) Inspection indicator.

1.5.11 UFA

The Uniform Fine Assessment (UFA) system is used for assessing fines for violations of the Federal Motor Carrier Safety and
Hazardous Materials Regulations.
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Fixes to UFA 3.2

· An issue that occurred when violations with a secondary were entered directly into UFA (not imported from CAPRI)
caused the secondary violation to not appear on the UFA report. This has been fixed.

· An error that occurred with Safety cases where if you did not check the Use Fine Reduction for More than One
Documented checkbox before increasing the Number Documented, the checkbox would disappear. This error has been
fixed.

Enhancements and Modifications to UFA  3.2

· An employee (i.e., driver, dispatcher) penalty assessment model has been incorporated into UFA. This model uses
nine statutory factors to consistently apply a  penalty that is based on the facts of the situation.

· The following new HHG categories have been added to UFA:  GBCA, GOLD,  and GUTR. These categories have
minimum fines of either $10,000 or $25,000.

· Proportional fine reductions have been added to HHG.

· Users are now able to select either state or federal violations of the same violation type (from CAPRI).

· All primary violations can now also be selected as secondary violations.

· The Violation Category on the Criteria page is no longer editable (unless it is blank).

· In UFA, the 392.9a(a)(1) and  392.9a(a)(2) violations now display as Operating Authority - Non-HHG.  When transferred
to CaseRite, the Operating Authority - Commercial Non-HHG category now displays for those violations, and the
commercial statutes will appear on the NOC.

· The user Help has been updated.

· The Public version of UFA 3.2 will be created and released after September 29, 2008 in accordance with the Freedom
of Information Act (FOIA).

1.6 Known Issues

Aspen

· When adding vehicle information for a TT (Truck Tractor) on the Vehicle tab, the International make does not appear.

To Add the International TT Make

1. From the Tools menu, select Manager Configuration.

2. Enter the Manager Password. The default is aspen.

3. Click the Table Editor button.

4. Select the Vehicle Make List tab.

5. Click the Add button.

6. Type "International" in the Vehicle Make column and press Tab.

7. Type "INTL" in the NCIC Code column and press Tab.

8. Type "TT" in the Type column and press Tab.

9. Close the Table Editor and International TT should now be available as a selection on the Vehicle tab.

CaseRite
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· When exporting to E-Mail, users receive the following error:

Click OK. Note: This error message is erroneous; the export e-mail is sent.

Query Central

· When a query is run, Query Central (QC) removes all non-numeric and non-alphabetic characters from the license
plate entry. Since other systems allow special characters that are entered in the license plate field to be stored in
SAFER, any queries that are run in QC using these characters will not return the queried information. For example, if a
license plate number is stored in SAFER as VT#21211, and VT#21211 is entered into the QC license plate field, the
query searches for VT21211, and no match is returned. 

All FMCSA Applications

· Users downloading and installing FMCSA software for the first time on a new computer may see the following
message:

Click Run to continue.

1.7 Technical Support

This document may explain or identify many general questions or issues that you may have noticed with the FMCSA IT
Development Division applications. However, you may still have concerns or questions. For more information, contact the
FMCSA Technical Support Team:

Phone   617-494-3003 Hours: M - Th 8AM - 8PM EST

           F        8AM - 6PM ESTFax   617-494-3058



10/6/200816

Release Notes

Web site   https://infosys.fmcsa.dot.gov

  FMCTechSup@volpe.dot.govEmail

http://infosys.fmcsa.dot.gov
mailto:FMCTechSup@volpe.dot.gov
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